AutoCAD/Civil 3D 2013
Engineering Survey
Plan Processing Guide

Geomatics Office
Highway Standards Branch
Provincial Highways Management Division

Ver. 2 - 2015 March 11
## Document Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Change</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014 Nov 19</td>
<td>Initial</td>
<td>For Publishing</td>
</tr>
<tr>
<td>2015 Mar 11</td>
<td>5. Updated Description key ref</td>
<td>Ver. 2</td>
</tr>
<tr>
<td></td>
<td>7. Updated ref to Fig Prefix db</td>
<td></td>
</tr>
<tr>
<td></td>
<td>13. Added tip for multiple pt description edits</td>
<td></td>
</tr>
<tr>
<td></td>
<td>14. Enhanced notes on figure edits</td>
<td></td>
</tr>
<tr>
<td></td>
<td>18.1 Pipe creation dialogue</td>
<td></td>
</tr>
<tr>
<td></td>
<td>21. Reference to station offset routine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>25. and Appendix A – Change to template: proxygraphics variable set to 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1, Appendix E – New MTO Custom Routines package added</td>
<td></td>
</tr>
</tbody>
</table>

## Inquiries and Comments

Inquiries or comments about this document should be directed to the

**Deputy Chief Surveyor**
MTO Geomatics Office  
301 St. Paul St. – 2nd Floor South  
St. Catharines, ON   L2R 7R4

Tel. 905-704-2919  
Fax 905-704-2051

## DISCLAIMER

This manual and associated CAD Standards files are provided on an "as is" basis as a public service.

Under no circumstances does the Ministry of Transportation (Ontario), (MTO), warrant or certify the information to be free of errors or deficiencies of any kind. MTO specifically disclaims all warranties, express or implied, including but not limited to the warranties of merchantability and fitness for a particular purpose.

The use of any of this information for work which is under contract or subcontract with the MTO does not relieve the user from any obligations assumed by the contract, or from complete and proper fulfillment of the terms of the contract, nor does it entitle the user to compensation for damages of loss which could be attributed to such use.

This information is subject to change by MTO. Anyone relying on this information should satisfy himself/herself as to the most current version. The user agrees to accept all risks and consequences flowing from or related to the use, retention, distribution, alteration, or deletion of this information. MTO will in no instance be liable for any loss of profit or other damage, including but not limited to special, incidental, consequential, or other damages, even if apprised of the likelihood of such damages.
| 1. | MTO Civil 3D Standards Components | 3 |
| 2. | Main Controls | 5 |
| 3. | Create a New Drawing for the Survey | 10 |
| 4. | Assign an MTM Coordinate Zone to the Drawing | 11 |
| 5. | Select MTO Standard Description Key Set | 13 |
| 6. | Ensure Survey User Settings are Correct | 14 |
| 7. | Select MTO Standard Figure Prefix Database | 15 |
| 8. | Create and/or Link to Survey Database | 16 |
| 9. | Importing Legacy Land Desktop Information | 18 |
| 10. | Import Control points | 20 |
| 11. | Import and Process Field Book Files | 22 |
| 12. | Update Point Groups | 25 |
| 13. | Check for Non-Standard Coded Points | 25 |
| 14. | Review and Edit Survey Figures | 27 |
| 15. | Create Existing/Original Ground Surface | 30 |
| 16. | Review Ground Surface | 34 |
| 17. | Check Audit Measurements Against DTM | 35 |
| 18. | Create Pipe Network Objects for Culverts | 37 |
| 19. | Add Parcel Fabric | 41 |
| 20. | Create Existing Alignment | 44 |
| 21. | Export H & V Information | 46 |
| 22. | Create Profiles of Mainline Highway | 46 |
| 23. | Add Drainage Features to Profiles | 48 |
| 24. | Summary of Deliverables | 49 |
| 25. | Creating Survey Data for Designers Using InRoads | 50 |
| 26. | Exploded Civ3D objects | 52 |
| 27. | Import to InRoads or Power InRoads v8i | 52 |
| Appendix A. | MTO Civil 3D Standards Files | 57 |
| Appendix B. | Other Standards Consideration | 62 |
| Appendix C. | Civil 3D Point Objects | 65 |
| Appendix D. | Layer Control in AutoCAD & Microstation | 67 |
| Appendix E. | MTO Custom Routines | 69 |
| Appendix F. | Additional Resources | 71 |
0. Introduction

This document is provided as a guideline for those using AutoCAD Civil 3D 2013 for processing engineering (topographic) survey data to MTO standards so that it will be readily useable by designers working on MTO projects.

This guideline should not be considered a detailed general training manual for AutoCAD or Civil 3D; rather, it is meant to provide information to readers who are already proficient with those applications to assist with the creation of standard MTO survey deliverables. The last appendix contains a number of additional Civil 3D learning resources.

Note that some surveying assignment terms of reference may not require all of the products that are described in this manual.

This guideline should be read in conjunction with two documents: The MTO Engineering Survey Manual covers project planning, establishing horizontal and vertical control networks, field data collection coverage, safety practices, and general plan processing and other deliverables’ preparation. Although there are references to Land Desktop software in the Manual, most information in is still valid. The Field Code Feature Sketches document describes the accuracies, codes for, and manner of measuring, points, symbols and line work for MTO engineering surveys.

This manual and the files it describes may be obtained from http://www.xfer.mto.gov.on.ca/PTASapps/index.htm
1. MTO Civil 3D Standards Components

The two key files that have been developed to provide assistance in creating standard MTO engineering survey CAD products are the blank drawing template (.dwt), and the survey figure prefix database (.fdb_xdef). These and other related standards files will be provided in a single zipped file for download from a public ftp site.

1.1 Standards Files List

The following files will be provided to assist with the preparation of survey deliverables:

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Template</td>
<td>MTO_Civ3D2013_3Dstds_vX_YYMMDD.dwt</td>
<td>AutoCAD Drawing with MTO standard layers, styles, groups, etc.</td>
</tr>
<tr>
<td>(with Point Description Key Set)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Figure Prefix Database</td>
<td>MTO Civ3D 3D SP PH YY_MM_DD.fdb_xdef</td>
<td>XML format file that controls the creation of survey figures from field codes</td>
</tr>
<tr>
<td>Compiled Shape</td>
<td>mt-ltype.shx</td>
<td>Describes MTO custom line types</td>
</tr>
<tr>
<td>Linetype</td>
<td>C3D mt-acad.lin</td>
<td>For MTO custom line types</td>
</tr>
<tr>
<td>Compiled Font</td>
<td>mtoeng.shx</td>
<td>Controls text appearance</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Geospatial Coordinate Systems.zip</td>
<td>Contains MTO MTM map projection systems for geo-referencing CAD and GIS data</td>
</tr>
<tr>
<td>Survey User Settings</td>
<td>MTO Survey User Settings.usr_set</td>
<td>Contains various user pathnames and defaults</td>
</tr>
<tr>
<td></td>
<td><strong>NB: Further user customization required.</strong></td>
<td></td>
</tr>
<tr>
<td>Survey Database Settings</td>
<td>MTO_Survey Database Settings.sdb_set</td>
<td>Defaults for interpretation and processing of field data</td>
</tr>
<tr>
<td></td>
<td><strong>NB: Further user customization required.</strong></td>
<td></td>
</tr>
<tr>
<td>Survey Equipment Database</td>
<td>MTO Sample.edb_xdef</td>
<td>Copy of Default Civil 3D Equipment parameters file</td>
</tr>
<tr>
<td></td>
<td><strong>NB: Further user customization may be required</strong></td>
<td></td>
</tr>
<tr>
<td>MTO Custom .NET Routines</td>
<td>IESCAD2013.bundle</td>
<td>Set of MTO routines used to assist with drafting and reporting</td>
</tr>
<tr>
<td>Pipes Catalogue</td>
<td>MTO Pipes Catalog FINAL</td>
<td>Can be used to modify pipe types and sizes, for importing into a drawing Parts List</td>
</tr>
<tr>
<td>Field Book for Partial Generation of Legend</td>
<td>Legend_Symb_Coords</td>
<td>For help in testing of Civil 3D standards set up</td>
</tr>
</tbody>
</table>

1.2 Drawing Template – MTO_Civ3D2013_3Dstds_vX_YYMMDD.dwt

This is a blank drawing in AutoCAD 2013 format that has been saved with a .DWT extension for ready use when beginning to draft with the File > New command. In addition to containing standard layers, blocks, styles, and command settings, it also includes the Description Key list that controls the automated CAD creation of surveyed points.
The drawing template follows the MTO AutoCAD Standards Guide Version 2004, but includes some additional layers to accommodate new Civil 3D objects that have been introduced or modified from MTO’s 2009 version of the Integrated Engineering System CAD (IESCAD) routines for Land Desktop.

Note that by default, Civil 3D will look for the template in

\[ C:\text{\textbackslash}Users\textless Username\textgreater \textbackslash AppData\textbackslash Local\textbackslash Autodesk\textbackslash C3D 2013\textbackslash enu\textbackslash Template \],

but you can browse from the same dialogue box to any directory of your choice.

1.3 Survey Figure Prefix Database: \textit{MTO Civ3D SP PH YY_MM_DD.sdb_xdef}

Survey Figures are Civil 3D objects that are used to represent string objects on the ground such as curb edges, ditch lines, and so on. The Figure Prefix Database is an XML format file that controls the creation of survey figures on the importation of standard field book (.FBK) files into a Civil 3D Survey Database. The selection of the figure prefix database is made via the Civil 3D \textit{Toolspace [Survey]} tab > \textit{Figure Prefix Databases}.

The default location for the Figure Prefix Database is a folder normally hidden in Windows 7, \[ C:\text{ProgramData\Autodesk\C3D 2013\enu\Survey} \], but this can be modified by browsing to any other folder via the Survey User Settings dialogue box.

1.4 Other Support Files

1.4.1 Compiled Shape

The files, \textit{mt-ltype.shx} (compiled shape file for linetypes) and \textit{mtoeng.shx} (for fonts) remain the same as those used formerly with Land Desktop. They should be in a support path such as

\[ C:\text{\textbackslash}Users\textless Username\textgreater \textbackslash appdata\textbackslash roaming\textbackslash autodesk\textbackslash c3d 2013\textbackslash enu\support \]

to be referenced by AutoCAD for proper presentation of linework and text, especially the scalloped woods detail linetype, which will otherwise appear only as a dotted line.

Go to AutoCAD and \{Right Click\} on the drawing window > Options > Files > Support File Search Path > to confirm your paths, or if you need to add an alternate path.

1.4.2 Linetypes

\textit{C3D mt-acad.lin} is a linetype file that has been modified slightly from the previously used IESCAD “\textit{mt-acad.lin}” file to correctly display some linetypes with embedded text.

1.4.3 Plot files

MTO colour table files (monochrome full and half sizes) that were used with IESCAD should be saved to \[ C:\text{\textbackslash}Users\textless Username\textgreater \textbackslash AppData\textbackslash Roaming\textbackslash Autodesk\textbackslash C3D 2013\textbackslash enu\Plotters\Plot Styles \]
1.4.4 Pipes Catalogue

Although the drawing template contains an MTO Parts List that can be used as-is without to create Civil pipe objects from culvert survey figures, there may be a need later to add additional sized pipe items to the list. This must be done by first modifying the pipes catalogue, then importing the new items into a drawing parts list.

The path to this catalogue is set from the Civil 3D [Home] Menu Ribbon > Create Design > Set Pipe Network Catalogue.

By default, Civil 3D places this Pipes Catalogue in C:\ProgramData\Autodesk\C3D 2013\enu.

For additional information on standards settings, refer to Appendix A.

1.4.5 MTO Customized Routines

A set of custom tools for MTO layer control, plan edits, and reporting has been saved as a zipped file for optional installation, and is described further in Appendix E.

2. Main Controls

Although a complete training course is beyond the scope of this guide, some key controls are described here for quick reference.

2.1 Workspace

The default workspace setting will be Civil 3D, but others can be selected from a top bar pull-down menu:

More basic AutoCAD drafting and raster management commands can be found by selecting the “2D Drafting & Annotation” workspace. Mapping and GIS functionality that was formerly in AutoCAD Map modules can be accessed using the “Planning and Analysis” workspace.

Although the “3D Modeling” workspace sounds like it may have application for Civil 3D survey work, it does not: it is instead intended for design and drafting of 3D architectural or mechanical subjects. The Civil 3D workspace will handle all routine 3D tasks for survey work requiring some visualization.

2.2 Civil 3D Toolspace

The Toolspace “palette” (panel) is the workhorse of Civil 3D as it provides the means to create and edit all Civil objects, styles and settings. It should show by default on startup, but can be toggled on and off by using the appropriately large left-most Toolspace button of the Home ribbon menu.
Like other palettes, it can be set open in a docked or floating position or set to “autohide” until the cursor moves over its margin. The panel’s transparency can be set by the palette’s properties control.

There are three tabs which we make use of extensively: they are the Prospector Tab, the Settings Tab, and the Survey Tab, described below.

A fourth tab, the Toolbox, can be toggled on as well using the small button with a red toolbox icon. It provides for the creation of some standard reports of Civil 3D objects.

**View Setting**

The tab at the very top of the Toolspace menu acts as a filter:

"Master View" allows you to view the prospector/settings branches of, or switch between, all drawings you have opened; this is helpful when dragging and dropping components from one drawing to another.

"Active Drawing View" restricts your view to only the prospector/settings components of the drawing that is currently active in AutoCAD.

If you have only one drawing open in "Master View", the two views will be the same.

### 2.2.1 Prospector Tab

The uppermost Prospector Tab is like an X-Ray into your working drawing. It provides view access and control for all the Civil 3D objects and groups for points, surfaces, alignments, pipes, and survey networks and figures. Selecting “branches” within the drawing tree will bring up lists of objects in an adjustable pane just below the tree. You can execute many commands with a right mouse click on branches or sub-branches of the tree.
2.2.2 Settings Tab

The Settings tab provides access to all the settings styles that have been set up in the MTO standard template to control things like default object layers, the appearance of points and surfaces, the default description keys, object labels, and so on.

For the most part, few adjustments will have to be made to the default settings of the template, but be aware that fine-tuning of drawing appearances are possible from within this tab.

Again, context-sensitive right-clicking on the branches of the settings tree will generally allow new settings to be created, or existing lists to be refreshed so that recent changes are made visible.
2.2.3 **Survey Tab**

The Survey Tab provides control over survey databases external to the drawing. Networks for organizing field control are created under this tab and provide a location for field data to be imported and reduced to coordinates.

Imported fieldbook files, ASCII coordinate files, and points already in drawings brought into a database and will appear under the “Import Events” branch.

Survey Figures, representing 3D linear ground features can be browsed and edited from this tab, and sorted into groups.

Similarly, survey points can be browsed and edited with Survey Point Groups within a survey database, but this feature is considerably less functional than the point groups control of the *Prospector* tab.

The *Equipment Databases* branch gives a way to apply corrections to specific sets of equipment.

**Finding Pathnames**

Note that full Windows path names of files can be revealed by either hovering your mouse over the database name in the Survey Tab, or by selecting the main branch and viewing in the small panorama window below the tree.

2.3 **Add Layer Control to Main Menu**

The LAYER pull-down is one that is commonly used during drafting, but unfortunately is only available in the HOME menu ribbon by default. If you would like to make it available at all times, set it in place as a quick menu item in the uppermost “Quick Access Toolbar” so it can be used regardless of which of the ribbon menus is showing.

Customize the Quick Access Toolbar by *Right Click*ing any command on a ribbon menu, and selecting **Add to Quick Access Toolbar**.

![Figure 7 – Right Click on a ribbon menu item to add it to the Quick Access Toolbar](image)
2.4 Annotation Scale

The Annotation scale is an AutoCAD drawing setting found near the lower right of your screen.

It will size civil point objects and survey figures and features lines appropriate for plotting at either of the two main scales used for MTO work, 1:1000 (the default) and 1:500.

![Annotation Scale Setting Resizes Symbols and Labels (and text, if annotative)](image)

Resizing Point Text

You can also choose any intermediate annotation scale during drafting to suit your display scale so that your view is not too cluttered with point number, elevation, and description labels. Pick a large scale (eg 1:250) if you are zoomed into a small portion of your drawing to make it easier to read all the text. Remember to reset the scale prior to creating plots.

2.5 Undo

The Undo back arrow button on the uppermost toolbar will let you reverse the last command, whether it is an AutoCAD or Civil 3D command. The small arrow to the right of the “Undo” button will provide a long list of your last commands used, and allow you to select any sized group of your last commands. Note that there is a separate “undo” button on the alignment menu.

![Undo Button to Reverse a Command](image)

2.6 Context-Sensitive Menus for Civil Objects

Some special ribbon menus will appear when a Civil 3D object is selected in a drawing. These “context-sensitive” menus will appear with green tabs to distinguish them from the
standard Civil 3D ribbon tabs. The menus appear when a civil object such as a survey figure, alignment, surface, or pipe is selected, and disappear when the selection is cleared.

Figure 10 – With a survey figure selected, a green figure menu will display with the name of the figure

2.7 Transparent Commands for positioning

Since many Civil 3D commands relate to positions, there is a means to permit existing points or new coordinates to be referenced from within commands: the transparent command toolbar.

Users should be familiar with all the options in this toolbar to allow, for example, designating position by northing & easting; bearing & distance; selecting existing points by point number or graphic selection; station and offset on surfaces, and so on. The toolbar also allows designating quantities within commands by selecting objects with the desired length or radius.

You can open the transparent toolbar by {Right Click}ing to the right of the display window, or by calling it up at the command line with \texttt{--toolbar \textasciitilde transparent\_commands}. You may find it helpful to keep this toolbar docked at the right of your display.

Figure 11 – Civil 3D Transparent Commands Toolbar is invaluable for many Civil 3D commands

3. Create a New Drawing for the Survey

3.1 Select the MTO DWG template

Select File > New > then browse to the MTO Civil 3D Survey Template .dwt and save to a new working drawing name. (If the browse dialogue box does not show up, your system variable FILEDIA is probably not set to 1. Simply type the variable name at the command line to change the value.)

3.2 Confirm Drawing Setup

The new drawing thus created should contain all the MTO standard layers, blocks, point description keys, layer states, layer filters, point groups, object and label styles suited for creation of the CAD plan and profile products; see Appendix A for details. Make a quick check using the AutoCAD LAYER command to confirm.
Generally, MTO-specific styles in the template are named with an MTO prefix. The template will also contain a number of Autodesk styles, but they will not affect the processing of survey data.

4. **Assign an MTM Coordinate Zone to the Drawing**

It is possible to produce a topographic plan in a drawing without assigning any AutoCAD coordinate reference system, but the best practice is to assign one right from the start. Having an assigned coordinate system is mandatory for MTO work as it allows:

- subsequent users of the Civil (or exported plain AutoCAD) drawing to be aware of the reference system used
- data exported in the XML format to have the geo-reference system parameters included in the header of the file
- users combining GIS or imagery data with the drawing the ability to perform the appropriate transformation for proper alignment

Ontario has been divided into different zones of the 3° Modified Transverse Mercator (MTM) projection systems for consistency. Zones 8 through 11 cover the southern part of the province from Ottawa to Windsor, while zones 12 through 17 cover the north from Quebec to Manitoba. The *MTO Engineering Survey Manual* has more information about coordinate systems.

4.1 **Edit General Drawing Settings**

In Toolspace [Settings] tab > (Right Click) on the *Working drawing name* > Units and Zone

![Figure 12 – Right Click the Drawing Name to Change Drawing Settings](image)

4.2 **Pick Appropriate Mapping Zone Co-ordinate System**

There are two relevant pull-down lists here by default: A [Canada, Provinces] list and a [Canada, Country and Grid] list. The one to use will depend on the project terms of reference, and should be evidenced by the COSINE or PPP primary control coordinates on which the survey is based.
New projects will call for either NAD83(Original) or NAD83(CSRS), with the later more likely to be used in future. The newer NAD83(CSRS) datum is a further refinement on the (Original) version that provides a consistent province-wide accuracy of a few centimetres.

**CAUTION:** Within Ontario, the horizontal difference between NAD83(ORIG) and NAD83(CSRS) coordinates will depend on location and may be as much as a metre, and in some areas, as much as 1.5 metres, so it is important to distinguish between systems. We are currently in a transition stage between (ORIG) and the widespread adoption of the CSRS system. Check your project Terms of Reference.

Mapping zones (projected) coordinate systems can be set by either
(a) [Right click]ing on the drawing name of the settings tab, or
(b) by using the Map Setup tab of the Planning and Analysis workspace menu ribbon.

![Planning and Analysis Workspace for Coordinate Systems](image)

The pull-down references a "coordsys.csd" file located at C:\ProgramData\Autodesk\Geospatial Coordinate Systems\.

MTM NAD83(CSRS) datums are available through the “Canada, Country and Grid” option.

**CAUTION:** The Autodesk default installation includes a coordinate system with a reference to an incorrect ellipsoid. The system named “CAN83-14” for a portion of MTO’s Northwestern Region under the “Canada, Provinces” category incorrectly references the NAD27 Clarke 1866 ellipsoid, rather than the GRS80 ellipsoid, which can lead to errors of 200m. An updated “coordsys.csd” file is available with an “MTO” category containing all the MTM NAD83 zone systems for the province.

![Figure 14 – Caution: MTM Zone 14 in the Default Installation has an incorrect ellipsoid](image)

**MTO Customized Coordinate List**

A new coordinate system subdirectory has been created with a new “MTO” category listed among countries. This contains revised codes and descriptions for coordinate systems to simplify MTO work. This subdirectory, “Geospatial Coordinate Systems” should be saved to C:\ProgramData\Autodesk\ (after backing up the default) and the computer rebooted for the data to be recognized. The MTO category will show up near the bottom of the countries list.
5. **Select MTO Standard Description Key Set**

As with Land Desktop, the Description Key Set controls the creation of symbols and labels that are created when field data is imported into the survey database. Unlike LD, the Civil 3D description key set resides within the drawing itself, not as a separate file. Only one key set
is provided in the MTO standard template. Select or confirm selection of the MTO Standard Description Key Set that is embedded in the template:

```
[TOOLSPACE] > [Settings] Tab > Point > Description Key Sets > <MTO_20150205>
```

![Figure 17 – Ensure MTO Standard Description Key Set is selected](image1.png)

Details on how the Description Key Set works and is edited may be found in Appendix A.

6. **Ensure Survey User Settings are Correct**

A sample **Survey User Settings** file ("MTO_Survey User_Settings.usr_set") is provided along with the MTO Civil 3D drawing template, but it may have to be edited for an individual user, depending on where various other files are to be accessed. You can change settings by way of an icon in the upper left most corner of the [Survey] tab of the Toolspace. Appendix B provides more information on this file.

![Figure 18 – Calling Up Survey User Settings, where pathnames may be edited.](image2.png)

By default, the Survey User Settings file is accessed from `C:\ProgramData\Autodesk\C3D 2013\enu\Survey\`. 
Caution: Be careful **not** to have the “Process linework during import” option toggled on in the User Settings when using field books files for survey figure generation, described in the next section.

Linework processing by linework code sets is an alternative means of generating survey figures, not covered in this guide.

Note that this file specifies the name and location of the **Figure Prefix Database** file, which is critical for automatic generation of MTO standard survey figures. This should be named a specific variant of **“MTO Civ3D 3D SP PH yy_mm_dd.fdb_xdef”**.

![Figure Prefix Database Settings](image)

**Figure 19 – Select “No” to “Process linework during import” when using MTO coded field books, and ensure the correct MTO Figure Prefix Database path and file has been selected (not as shown)**

7. **Select MTO Standard Figure Prefix Database**

For the purpose of this guide, the treatment of Field Book (.FBK) files with standard MTO coding for survey figure creation that was used in the past with Land Desktop is continued. If you have more than one Survey Figure Prefix Database file, for example, to handle work of other clients, you will want to ensure the most current MTO standard Figure Prefix Database is selected for MTO processing.

Choose

```
TOOLSPACE > [Survey Tab] > {Right Click} <MTO Civ3D 3D SP PH Figs>
and “make current”
```

With a Figure Prefix Database thus selected, its name will appear as a bolded font in the tree:
Again, note that Civil 3D provides an alternate means of autogenerating linework, using “Linework Code Sets” listed in the branch just below that of the Figure Prefix Databases. The use of code sets should **not** be confused with figure prefix databases, and they are not described in this guide.

8. **Create and/or Link to Survey Database**

Civil 3D is primarily a design tool with survey capabilities. Having a survey database separate from the drawing helps organizations maintain some separation between the processing of existing ground information and new design models. Processing surveyed points, survey networks and existing ground feature linework within Civil 3D is primarily done within a **Survey Database**. Such a Survey Database must be first created, or, if it already exists, opened for appending any new survey work.

By default, survey database points are locked so they won’t be inadvertently modified by designers.

Although new points that are created in the drawing can be added to the survey database, they need not be if they are not critical for survey processing. At some point in processing, the survey database should be left alone without an expectation that it has to be updated with new points or features created in the drawing that are not part of the field survey; the drawing should be considered as the primary deliverable.

8.1 **Set Working Folder for Projects**

A standard working folder can be specified for the location of survey databases from the same menu.

Use:

```
[Toolspace] > [Survey] tab > Survey Databases > {Right Click} > Set working folder,
```

as required. You will want to exercise consistency with the working folders: see Appendix B for suggestions.
8.2 Create a New Survey Database

You will probably want to create a new survey database for each new project, and maintain either a one-to-one or one-to-many relationship between project and drawing(s).

Use Survey Databases > {Right Click} > [New local survey database]

Note that points created in the survey database are independent of the drawing but can be written to the drawing at any time. Conversely, Civil cogo points in the drawing can be written to the survey database, but there is no need to add points that have no relevance to the survey.

Caution: Civil 3D appears to prohibit the writing of drawing survey figures to a database other than the one from which they have been derived. In other words, if you create a completely new survey database, and open it for editing while in a Civil drawing, and then select a drawing figure (or figures) and attempt to {Right Click} > Update Survey Data from Drawing, an error message will be repeated for every object in the selection set.

Figure 21 – Right click to create a new survey database

8.3 Open an Existing Database

In some cases you will have a database that already exists that is to be linked to a drawing, such as when you receive a delivered project, or want to work on a project previously worked on, or when working on different drawings simultaneously, and so on.

If you have opened a drawing and need to link to an already-existing survey database, use

Survey Databases > {Right Click} <Your Survey Database Name> and “Open for Edit” or “Open for read-only”, as needed.

If you opened a survey database for “read only”, then decide later to edit it, you must close it first and then reopen for edits.

8.4 Survey Database Settings File

A number of settings can be saved with each individual survey database. These various items will affect the interpretation of field data, the flagging of items outside tolerances, set traverse adjustments and the display of coordinates on generation, and so on.

Settings can be exported to, or imported from, a Survey Database Settings file, (extension .sdb_set), which by default will reside in C:\ProgramData\Autodesk\C3D 2013\enu\Survey. Likely, a given department or user will want to standardize this file, or a set of similar files, for consistent repeat use.
From the [Survey Tab], *(Right Click)* on the *<Your survey database name>*>, then “**Edit survey database settings**”

![Edit survey database settings](image)

**Figure 22 – Right Click the Survey Database name in Survey Tab**

You can import an existing file of settings with an icon at the top of the panel. Review all the settings to ensure they are appropriate for your project, and modify as needed.

![Modify settings within the list as needed](image)

**Figure 23 – Modify settings within the list as needed**

Finally, save changes for later use by using the other (unfortunately, similar-looking) icon at the top of the panel.

![Import or Export Survey Database Settings using the icons at top](image)

**Figure 24- Import or Export Survey Database Settings using the icons at top**

9. **Importing Legacy Land Desktop Information**

(Use where applicable. If not, proceed to the next section.)

MTO has many projects that were processed using Autodesk’s Land Desktop software, portions of which may still be of value for new design or for checking new survey work. If information is to be taken from an existing Autodesk Land Desktop (LD) project, the following steps should be followed:
9.1 Import Land Desktop Components

Provided the path and project directories are set appropriately, this command sequence will allow the importing of Land Desktop (LD) surfaces, LD alignments, and any LD parcels from an existing LD project subdirectory.

Use [INSERT] tab > Import > Land Desktop

![Figure 25 – Import Land Desktop project information](image)

**Note:** Some testing indicates that the alignment list may not consistently populate with the LD alignments on the first try; if this is the case, try closing the drawing and reopening. This may be related to the Civil 3D help instructions that read,

> It is recommended that you import one data type at a time. For example, first import surface data and then repeat the procedure to import description keys or other data types, one data type at a time.

Answering “OK” once the desired boxes are checked should yield a “successful completion” message, and the toolspace **Prospector** tab can be checked to confirm that the new Civil objects have been added to the drawing.

**Legacy Alignment Data:** Civil 3D will not import pre-2004 Land Desktop alignment databases (.add files), but will import the latter Microsoft Access (.adb) format. LD 2009 can import pre-2004 alignments then save to 2009 format.

9.2 Import Land Desktop Points

Land Desktop (LD) points can be imported as well, but with a separate command on the Insert Menu:

**Import > Points from File**

![Figure 26 – Points file import](image)

Pick the file format “External Project Point Database” first, then browse to the LD point database (points.mdb) via the `<LD projectname>\cogo` subdirectory.

Again, some testing has shown this may not be possible on the first attempt under some conditions. If that is the case, the LD MS Access .mdb point database could be converted to a
standard ASCII text file, such as a comma-delimited PENZD file that can be read in with the same command using the MS Access and/or MS Excel applications.

**Caution:** Avoid importing description keys and overwriting the new MTO standard Civil 3D description keys.

For drawing features, the original LD drawing can be XREF’ed into the Civil 3D template originated working drawing as needed.

### 10. Import Control points

(Use where applicable. If control points are part of a fieldbook to be processed, proceed to the next section.)

Survey control points may come from different sources. They may have been created from a project independent of the topographic data collection survey. They may have been processed and analyzed in an application other than Civil 3D. They may be part of the same field books files that contain the field detail. Regardless, it is important that all control points are accurate and complete prior to processing the topographic measurements that are dependent on them. This section provides some ideas on treating control points from different sources, such as a text file, drawing or XML file.

In many cases, control points will be in the data file from the field download.

**Note:** Use `<SurveyDatabaseName>` {Right Click} > [Import] > [Import Survey Data] Wizard to select points by number or selection as needed from the drawing.

Alternately, the following command sequence imports all points into the survey database:

![Figure 27 – Importing Points from Drawing](image)

**Notes:**
- Control points imported from a drawing can be designated as either control or non-control points.
- Control points that are imported from a Field book (.FBK) file that are to be recognized as control points, should be prefaced with “NE” or “NEZ” as appropriate in the file.
10.1.1 Control Points On-The-Fly

Control points can also be created within a named survey network by (Right Click)ing on the Control Point branch > New, and then by manually entering coordinates or by graphically picking points in the drawing. These new points will be saved in the survey database, and can be inserted into the drawing by first selecting and (Right Click). (Note: Testing indicates AutoCAD will zoom in very close to the centre of the point after insertion, so a zoom > previous may be needed afterward.)

![Figure 28 – New Control Point Creation](image)

10.1.2 Survey Command Window

As with Land Desktop, Civil 3D 2013 allows working with batch files to create points and figures and perform inverses and intersections by means of issuing Field Book type commands. This is done by way of the survey command window, invoked by

(Right Click)ing a named network > [Survey Command Window].

Survey commands can be saved to a batch file that can be edited and re-run any number of times. The results of the commands can be saved to an output file.

All commands are described in the Civil 3D help file under Survey > Survey Command Reference. This reference can also be called up by typing HELP at the prompt line.

Depending on the Field Book commands used, points created with the Command Line will be classed as control, non-control, or topo points.

![Figure 29 – The Survey Command Window can be called up with a Right Click on a Network](image)

Points created will be inserted into the drawing by default, but can be removed selectively from either the survey database or drawing, or deleted altogether.
10.2 Quality Check Control Points

It’s good practice to check any control points being imported from field sources against those on record (MNRF COSINE database printouts, NRCan Precise Point Positioning (PPP) results, etc.), to ensure any manual entries have been made correctly.

10.3 Drafting Edits

Edits should be made throughout the drawing so that control point information is not obscured by any overlapping features, including contours, etc. Point markers can be rotated independently of text labels, and text labels can be moved independently of the markers. The set of MTO custom routines in Appendix E provide a way to rotate multiple labels based on highway alignment.

11. Import and Process Field Book Files

11.1 Field Book Edits

In some cases, you may want to correct problems by editing the field book (.FBK) file. For example, if an incorrect survey code has been used for multiple points in the same way, a text file search-and-replace operation could save a lot of time over having making the same corrections repeatedly in the survey database. And if notes from the field crew indicate that edits are needed to correct bad rod or instrument heights, etc., it is best to fix them in the field book before measurements are reduced to co-ordinates.

Before editing, make sure the original field book has been saved unmodified to a safe location for archiving.

The Windows Notepad application will open with the .FBK file by default, but this is an option that can be changed by the user. In Windows 7 File Explorer, {Right Click} the file name and choose Properties > Open With (under the General tab) > and select your preferred text editor. Just make sure the editor saves files as simple ASCII text, and not a binary or otherwise encoded format.

11.2 Ensure Survey Database Settings are Set Correctly

{Survey Tab} > [<Database name>] > {Right Click} > [Edit Survey Database settings]

Note that these settings can be saved to or imported from a Survey Database settings file using the icons on the top of the dialogue box.

Logging Database Changes

Note that at the end of the list there is an option to log changes to a text file. This will keep a record of all changes made to the survey database. The log may be viewed by Right-Clicking the <Databasename> > Display Change Report.
11.3 Set or Confirm Tolerance Checks

Problem measurements are best caught and corrected in the field. This can be done with field data collectors set to flag check measurements that are outside a specified tolerance. In some cases, however, a field file may contain check shots to the work of a previous day or another crew. Civil 3D can be set to do tolerance checks as well. If the “Ignore tolerance errors” setting in the Survey Database Settings is set to OFF, tolerance checks will be performed and reported, alerting you to possible bad station, prism, prism pole, measurement or point numbering entries in the survey data.

11.4 Select Target Network or Create New Network

Networks allow you to organize large multi-component projects in a way you want, for example, by field collection day, location segment, etc.

You must create a network into which a Field Book will be imported, either independently within the Survey Database or during the importation “wizard” sequence.

For the first option, use `<Survey database> > Networks > {Right Click} > New`.

To use the import wizard instead, use

`<Survey database> {Right Click} > Import > Import Survey Data.`
11.5 Editing Field Book after Importing

(Right Click)ing on the Network name of a Survey Database in the Survey Tab provides an option to “Edit field book”.

After making fieldbook edits and saving and closing the file, you can reimport it by (Right Click)ing on the <filename>.fbk branch of the Import Event of the Survey Database in the Survey Tab. **Note:** Re-importing will automatically erase all the objects that were created on a previous import.

11.6 Review Figures and Survey Points

Surveyed line work and point measurements will be created automatically in the form of Civil 3D survey figure objects and Civil point objects and added to the drawing if those options are selected when importing.

Figures and survey points are shown under the “Import Events” > <filename>, while control points and setups appear under the “Networks” header.

It is also possible to import figures and points into the survey database only, then import the figures and points into the drawing later.

When the field data is imported, the tolerance flags will be listed in the Event Viewer Panorama dialogue box.

![Figure 32 – Out of tolerance coordinates flagged](image)

**Regenerate Drawing to Display Linetypes**

Depending on the zoom factor of your display, an AutoCAD “Regenerate All” (REA at the command prompt) may be needed so that standard line types are displayed correctly.

11.7 Review Out-of-Tolerance Measurements

The observation tab next to the event viewer will show all the station setups, backsights, and topo observations, with out-of-tolerance items flagged.

![Figure 33 – Flagged items may need attention](image)

If measurements are well outside acceptable tolerances, the reason for them will have to be determined and corrections implemented. In some cases, you may deduce that an instru-
ment or rod height has been entered incorrectly, or an incorrect target point number has been assigned to a backsight, foresight, or check shot.

In the worst case, you may not be able to determine a cause, and fieldwork will have to be repeated.

12. Update Drawing Point Groups

After importing data, [Right Click] on the Point Groups branch under the Prospector tab and Update so that the point groups are populated with the new data so that they can be used as intended with other program functionality. The groups with content will then be indicated with black dot icons next to the group name.

![Figure 34 – Remember to Update Point Groups after Database Changes](image)

**Note:** It’s important to update point groups **whenever** you have finished a session of point edits or additions, so that they properly reflect all the points they are meant to represent. Civil 3D does not do this automatically by default.

13. Check for Non-Standard Coded Points

Some points may have been coded incorrectly, or may have been given a field code that was created in the field. In these cases, the points will not be layer-mapped or assigned the correct MTO-standard symbology. These points will appear on AutoCAD drawing layer **SP-E-PTS-UNKNOWN_CODE** with a large white marker comprising an X and a square, and labelled with point number, elevation, and description.

![Figure 35 – Appearance of points with non-standard codes, in this case “AH”](image)
These points should be reviewed in the drawing and corrected, or new description keys should be added and assigned to the points. You should strive to use only the standard keys for consistency, but if new ones are added, document these in the final report of the assignment.

Non-Standard Survey Figures

Survey figures that have been generated from improperly coded points will also be sent to the layer SP-E-PTS-UNKNOWN_CODE by default. These will have to be modified manually if the fieldbook is not reimported.

Editing Survey Point Codes

Selecting a point and **Right Click**ing will provide the option to Edit Survey Point Properties from a dialogue box.

![Figure 36 – Point selected for code edit](image)

After doing so, use the same Right Click on the selected point to **Apply Description Keys** to automatically update the point’s style in the drawing to reflect the new code.

![Figure 37 – Apply Description Keys to update point style of edited point](image)

Applying description keys in this manner may also be done after selecting any number of cogo survey points simultaneously in the drawing and Right Clicking.

Editing Descriptions of Multiple Survey Database Points

Note that the descriptions of several points can be changed to a single new description by selecting the points in the survey point panorama, **Right-Clicking** the “Description” header, and selecting “**Edit..**”. The new code can be entered in the top-most record, and all others will be revised. Pressing the disk icon at the upper right will save the changes.
14. Review and Edit Survey Figures

Review the drawing to see that the line work makes sense: that there aren’t gaps in the strings, or overlaps, or misconnections.

Fieldbook Edits: In some cases, you may want to correct string problems by editing the fieldbook (.FBK) file. As mentioned above in section 11.4, (Right Click)ing on the Network name of a Survey Database in the Survey Tab provides an option to “Edit field book”, and (Right Click)ing on the allows re-importing of the field book.

Figure 39 – You can edit a Field Book from the Survey Menu, then Re-import

At some point, you will want to cease all edits on the field book and from thereon, edit only the survey database, survey figures or feature lines, drawing file and surface. Those strings that will appear on the final plan should be fixed first.

If there are problems with the field strings, Civil 3D has a number of tools for correcting them within the Figure > Edit Geometry tool that allows the insertion and deletion of vertices, breaking and joining and reversing of features, etc.. Selecting the figure will bring up the contextual survey figure ribbon menu:

Figure 40 – Edit Geometry Button on Figure Context-Sensitive Menu

Pressing the large [Edit Geometry] button will expand a detailed editing menu to the right. Edit survey figures as needed and explained in the section further on, 14.3.

CAUTION: Do not use AutoCAD commands to edit survey figures in the drawing, or they will lose synchronization with the database.

Figures may be created interactively by connecting points and assigning the appropriate MTO standard feature code. These are added to the survey database only, by default, so they must also be added to the drawing as well either individually by (Right Clicking) the fea-
14.1 Correct the Directions of Patterned Lines

The reverse direction button under the Figure > Edit Geometry menu is very useful for applying to those figures with an asymmetrical linetype pattern facing the wrong side, such as woods detail (WD) and woods overhang (WO), hedge (HE) and top of rock cut (TC).

![Image showing Reverse direction button]

Figure 41 – Use the Reverse direction button to correct pattern lines

**Note:** Only correct figure directions when you are sure that you no longer need to re-import the field book that generated them.

14.2 Find and Resolve Crossing Breaklines

You can systematically find crossing breaklines in different ways using the [Analyse] tab of the Civil 3D ribbon menu.

[Analyse] > Ground Data (pulldown panel) > Resolve Crossing Breaklines will allow you to select either a survey database or a surface or a particular type of figure to analyse, and then pop up a panorama view of a list of all crossings, with the elevation differences calculated for each.

![Image showing Ground Data tab]

Figure 42 – Pull Down the “Ground Data” tab on the Analyze Menu Item

Selecting a survey database breakline crossing in the list will highlight the two strings in contrasting red and blue colours on the drawing screen, even if they haven’t been imported to the drawing. The command will permit zooming to the extent of the two strings.

You can choose to average the elevations if the difference is small, or you may want to select the breakline elevation that is more appropriate (such as where a breakline crossing is the result of an incorrect connection of strings.) For either case, Once the “resolve” button is pushed, a new vertex will be inserted at the crossing and the flagged set will be removed from the Event Viewer list.
A third option is to delete a breakline altogether if doing so will not adversely affect the creation of the ground surface model. This has to be done using the survey figure browser, not the crossing breakline event viewer.

14.3 Modify Survey Figures

If field coding is less than perfect, there are a number of edits that Civil 3D allows. Survey figure segments may be added, deleted or trimmed.

14.3.1 Add Survey Figure Segments

First, draw a 3D polyline between two figures (ACAD command “3DPOLY”), snapping to their ends. Then:

- [Survey Tab] > [Survey Databases] > Survey database Name \ Figures \ Right Click
- [Create figure from object]

Dialogue field: surface_name (eg, OG); Current Figure Prefix database; Associate survey points to vertices: No; Okay
(Select 3D polyline object)

Message: “Figure OG created”. (Figure is written to Figure database, but not to drawing.

Note: You can also create figures interactively by picking Cogo points for vertices, then inserting the figure into the drawing.

14.3.2 Select and Delete 3D polylines

Select the OG figure in the list of figures and its position will highlight in the drawing; {Right Click} > [Insert into drawing]. You can find it at the end of the list of like codes, when the view is sorted by code.
14.3.3 **Join Figure Segments**
Select the figure, and pick “Join” under the [Edit Geometry] tab of the Figure Menu.

![Figure 45 – The Join command will work on several objects](image)

14.3.4 **Delete Figure Segments**
Use Trim or Break from the Figures menu to tidy up extra or crossing figures.

14.3.5 **Add to Survey Database**
Pick the figure in drawing and **Right Click** > **Update Survey Data from Drawing** in order to keep the survey database synchronized with your drawing changes.

![Figure 46 – Right Click the drawing figure to update database](image)

14.4 **Modifying Planimetry with Feature Lines**
The method of editing survey figures described above is somewhat round about. An alternate method is to use Civil 3D **feature lines** to correct or supplement surveyed line work. Feature lines are similar to survey figures and can be edited and analyzed like survey figures, but they reside in the drawing only, and **not** in the survey database.

**Strings Not visible on the Plan** – If incorrect strings such as OG-code are adversely affecting the surface, you may want to simply edit the surface object triangles, since the OG-code strings are not viewed in the final plotted plan.

15. **Create Existing/Original Ground Surface**
In this Guide, “Original Ground” (OG) here means “existing ground”, the ground as it exists at the time of survey, whether man-made or not, and not some pre-construction natural surface below existing highways.

The original existing ground surface must be defined from those survey figures and single cogo points that have been designated in the MTO standards for DTM use, i.e., with the **Model** or **Both** (plan and model) designations.

One way to do this, described in the next few steps, involves creating breaklines from the survey figures, creating the surface, and then supplementing the surface with any surveyed single-shot cogo points. This method makes use of the MTO standard figure database and
description key set that have already been set up in Civil 3D with the appropriate DTM features designated as such.

The original ground will normally be the lowest continuous surface from start to finish along a route and may include beds underneath water bodies but exclude any bridge deck (span > 3 metres) structures, whether or not they form a crossing for the main route. Bridge deck surfaces should be created separately from the OG surface of the route that they cross.

15.1 Bridge Deck Treatment

Isolate bridge decks from the OG

Bridge decks may be processed in a separate drawing where the bridge data is contained in a fieldbook separate from the rest of the survey. If deck data is part of the general survey, however, and imported along with the surveyed OG features underneath them, then it will be necessary to designate deck strings as non-breakline figures in order to model just the ground surface below.

Do this by selecting the first figure, \{Right Click\}ing > Edit Survey Figure Properties > then un-checking the breakline option box to “No”. Repeat for all such bridge deck strings not desired for the ground model below.

![Figure 47 – Designate bridge strings as non-breaklines when they are to be excluded from OG](image)

(Alternately, you can \{Right click\} and > Browse to Survey Figure to uncheck the object’s breakline status, but the above methods provides for slightly easier reading and modification.)

Create Bridge Deck Surface(s)

After the OG surface has been created and reviewed and corrected, as explained in detail previously, bridge deck surfaces, or a single surface for all bridge decks, should be created for all bridges by:

- Turning on DTM layers only, using the drawing filters
  - Eg., Filter All layers > frozen
  - Filter DTM Features > DMT SP- > thaw
- Creating a new Bridge deck surface
- using the Breaklines > Add Breaklines > (graphic selection) command under the surfaces menu item to select the bridge breaklines only
• building and saving the surface(s)

Once bridge decks have been modeled, it may be wise to save the deck TIN triangles on a separate layer or in a separate drawing for subsequent deck surface creation in InRoads.

15.2 Create OG Breaklines from All Figures

The create breaklines dialogue box appears by selecting {Right Click} on the Figures item under the current survey database selected in the Survey Tab.

![Create Breaklines to Initiate Surface Creation](image)

Specify a new OG surface as the destination surface for the breaklines by selecting the surface icon (pentagon) on the dialogue box.

The Civil 3D surface object will be created on AutoCAD layer SP-E-TIN by default, but it may be necessary to click the AutoCAD display area in order for it to appear.

Note that certain TIN settings can be changed by selecting the surface object and {Right Click}ing Surface Properties to access the Definition tab > Build option.

15.3 Add Single Points for DTM Using the Point Group

These are the points that represent single point DTM features, specifically, for

- ground survey (SP-) features, they are bullnose centre (BN), catch basin (CB), ditch Inlet (DI), and maintenance hole (MH), provided; and for
- photogrammetric (PH-) features, CB and MH

Obviously, any MH cogo points that were surveyed on maintenance holes that protrude high above the ground surface should not be added to the original ground surface object.

Note that the option to add “Drawing Objects” to a surface definition only allows for the selection of AutoCAD drawing objects, not civil objects. Accordingly, a Civil point group has been created in the template to allow their automated selection.

Add these single points to the OG surface by {Right Click}ing on the Point Groups item in the OG surface definition in the Prospector tab, followed by Add > “MTO SP Single Points for DTM”.

---

Plan Processing Guide Ver. 2
15.4 Alternative Method for OG Surface Creation

Another method of creating the ground surface is to do so by graphical CAD means, that is, by:

(a) Creating and Naming the surface in the prospector tab

(b) Turning on only those AutoCAD layers that contain breakline survey figures designated by MTO standards for the DTM, by either setting a predefined layer state, or by using the layer filters appropriately;

I rendering invisible those bridge deck strings that need to be removed by assigning to them a non-visible figure style, such as MTO Std Figure NOT VISIBLE

(d) Adding the DTM features that are visible using {Right Click} on the Breaklines component under the Definition, then

I Selecting the features with a window over the drawing content

(f) Single points features will also have to be added to the surface using the point group, MTO Single Points for DTM, as described for the method of section 15.3

Note: Be cautious with this method, however, because any 3D line, grading feature lines, 3D polylines, or spline features on CAD layers inadvertently left turned on will be included in the surface, including such non-DTM items as fences, property lines, etc.
16. Review Ground Surface

16.1 Select Surface Style for Review

It is useful to view all the figures and a surface style showing fairly dense contours in order to be able to clearly “read” the surface in 2-D plan view. In the standard template, a surface style with 0.25m interval contour lines, TIN points and TIN triangles has been created for this, as well as a variety of styles with some component displays set to on or off.

Review the contoured-styled surface to look for any spikes or hills that look out of place, as these may indicate points not intended for the DTM, or points with erroneous elevations. Also check that sufficient breaklines have been used to control the surface model at the edges of ditches, rock faces, and so on.

Use AutoCAD’s Display Order function to control visibility

To make survey figures visible, reposition the surface object behind the survey figures by selecting the surface and {Right Click}ing to change the AutoCAD display order to “Send to Back”. This will allow the coloured feature lines to be seen on top of the TIN lines.

16.2 Line Work Edits – An Alternative to Survey Figure Editing

The above method of editing survey figures described earlier is somewhat arduous, so an alternative process involving the use of feature lines, instead of survey figures is suggested here.

Bear in mind that Civil 3D feature lines become part of the drawing only, and not the survey database.

1. Select the target layer from the layer pull-down or the “Make Object Layer Current” command
2. From the Home Tab, pull down the [Create Design] tab > [Feature Line] menu
3. Add feature lines as needed, as though they were survey figures
4. Select the newly created feature line and from the contextual ribbon menu or {Right Click}ing, add it to the original existing ground surface as needed.
16.3 Edit TIN Triangles Where Needed

In some instances, a DTM may need corrections that are independent of the survey feature strings. One manner of correcting the TIN calls for the “flipping” of triangle edges with the command available in the surface object contextual ribbon. Flipping an edge removes the side joining two opposite corners (vertices) of a quadrilateral, and joins the other two corners.

Where elevations are obviously wrong, and their correct elevations are unascertainable from existing field notes, you may have no choice but to edit the TIN by deleting points (triangle vertices) within it.

TIN points can be removed only if they are visible in the drawing by having the points component switched on in the current surface style. A style has been set up in the drawing template that shows TIN points visible as small circles, named, “_MTO_SP_Contours .25m + Triang + Bdry + Pts”.

![Figure 52 – This Surface Style has Points Visible as Small Circles, to allow surface point editing](image)

Editing surface object TIN points will not affect the corresponding cogo point objects or survey figure vertices in the drawing: they will only affect the Civil surface object.

Locking the Surface

When you are satisfied with the accuracy of your surface model, it can be locked to prevent further unwanted changes. Use the menu item from a right-click on the surface name.

17. Check Audit Measurements Against DTM

The DTM of a topographic survey is normally checked by comparing the elevation of audit points—typically picked up in the form of strings at regular intervals along the length of a project, independently of the topo survey—against elevations interpolated on the DTM that has been created in CAD.

A routine has been included in the MTO customized Autodesk Application Plugin to perform a simple elevation comparison between audit points and a Civil surface; See Appendix E for details.

The following is an alternate suggested manual means of checking DTM elevations with random audit point measurements using only Civil 3D functionality.

In overview, this calls for:

- Creating a surface from only the audit points (valid only at the points themselves)
- Creating a Civil 3D “Volume DTM” between the audit point surface and the OG surface
- Labelling the “elevations” of the volume DTM at all points

The following describes the process in detail:

17.1 Import Audit strings from FBK
Audit strings are likely to be either field book or simple ASCII coordinate files or Land XML. Import using the method appropriate, i.e., using Survey Database import field book,

[Insert] > LandXML  or  [Insert] > PointsfromFile

17.2 Create a DTM From All Audit Strings Alone
Isolate the audit points or strings from all other data and use the standard Civil 3D surface creation commands to create a DTM surface. The surface will only have any meaning except at the actual audit points, of course, and not in between, but that is not important for the purposes of this section, because it is just an intermediate step.

Give this surface a unique identifying name, such as "Audit YYYYMMDD".

17.3 Create a Volume Type DTM between the OG Surface to be Tested and the Audit Surface
Civil 3D, like Land Desktop before, allows the creation of a “differential” or “Volume” CAD model that actually represents the elevation differences between two other surfaces. Do this with the following steps:

1. [Prospector] > [Surfaces] > {Rt Click}[Create Surface] > (pull down) [TIN volume surface]
2. Assign this a new name with Name: (for example) “ToleranceCheck”
3. Base Surface: Choose the existing surface, e.g. “OG surveyed July 2013”
4. Comparison Surface: Specify the newly created surface e.g, “AuditYYYYMMDD”, from above

17.4 Label Spot Elevations of Volume DTM at Audit Points
The “elevations” will actually represent the difference between the audit string point measurements and the interpolated existing DTM elevations. “ToleranceCheck” A label may then be added with {Right Click} > Add Label.

The default label style will be “diameter (mm) x slope length (m) ‘Description’.”
If you are labelling a rectangular or arch culvert with different width and height, you will want to change the label style to a rectangular one. Select the label, and change its “Pipe Label Style” property to the Non-Circular culvert option.

The automatically generated pipe dimensions of the label can be refined: Select the label only and (Right Click) > Edit Label Text to pull up a dialogue box that will show the programmed values and other text items in a window. Make modifications as needed.

![Figure 53 – Modifying pipe label text](image)

18. Create Pipe Network Objects for Culverts

**Note:** Where profiles are to be created, it may be helpful to have highway alignments created first as described in Section 21. This allows the centreline culverts under the main highway to be referenced to the main alignment when being created by using a pull-down list.

Whereas former MTO IESCAD routines for Land Desktop permitted the drawing of culvert walls in plan view by simply parallel-offsetting the centreline feature string, Civil 3D permits the creation of 3D pipe objects with attributes. While these attributes can allow various drainage networks to be analysed for design purposes, here they are used only as a means of automating drafting for survey purposes.

Creating pipe objects is contingent on having a Parts List, “_MTO Surveyed Culverts”, in the MTO standard drawing template. This can be found under the [Settings] tab > Pipe Network > Parts List branch.

![Figure 54 – Pipe Network Parts List Showing MTO Standard Culvert Types and Sizes](image)

Culvert abbreviations in the list follow those set out in the MTO Field Code Feature Sketches document, but are provided here for convenience:
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP</td>
<td>Concrete Pipe</td>
</tr>
<tr>
<td>CSP</td>
<td>Corrugated Steel Pipe</td>
</tr>
<tr>
<td>CSPA</td>
<td>Corrugated Steel Pipe Arch</td>
</tr>
<tr>
<td>PP</td>
<td>Plastic Pipe</td>
</tr>
<tr>
<td>SPCSP</td>
<td>Structural Plate CSP</td>
</tr>
<tr>
<td>HECPC</td>
<td>Horizontal Elliptical Concrete Pipe Culvert</td>
</tr>
<tr>
<td>RFO</td>
<td>Rigid Frame Open</td>
</tr>
<tr>
<td>NRFB</td>
<td>Non Rigid Frame Box</td>
</tr>
<tr>
<td>RFB</td>
<td>Rigid Frame Box</td>
</tr>
<tr>
<td>NRFO</td>
<td>Non Rigid Frame Open</td>
</tr>
<tr>
<td>RFO</td>
<td>Rigid Frame Open</td>
</tr>
<tr>
<td>CTCT</td>
<td>Creosoted Timber Culvert – Triple</td>
</tr>
<tr>
<td>CTCD</td>
<td>Creosoted Timber Culvert – Double</td>
</tr>
<tr>
<td>CTC</td>
<td>Creosoted Timber Culvert</td>
</tr>
<tr>
<td>CSPA</td>
<td>Corrugated Steel Pipe Arch</td>
</tr>
<tr>
<td>SPCSPA</td>
<td>Structural Plate CSP</td>
</tr>
</tbody>
</table>

Currently, no standards for manhole structures have been included in the MTO Parts List of the drawing template, except for a null structure, which will not be visible in the drawing. There are several structures included under the Civil 3D default Storm Sewers parts list, but these will not be expected to be added to plans or profiles. Modelling of structures may be implemented in a later version of these standards.

The following describes the creation of pipe objects from Top of Culvert (CVT code) feature strings to permit their automated drafting in plan and profile views:

**18.1 Create a Civil 3D Pipe Object**

Create the pipe object using the sequence,

**[Home] ribbon > [Pipe Network] (of Create Design) > [Create Pipe Network from Object]**

![Create Pipe Network from Object](image)

Figure 55 – Create a pipe object by creating a pipe network from a figure

Pick the MTO standard “Culvert Top” CVT feature string. A white “flow direction” arrow will appear but may not necessarily reflect the high-to-low invert direction of the culvert as might be expected. For simple drafting purposes, you can select “OK” or “Enter”, regardless of direction. A pipe network creation dialogue box will appear.

The default MTO Parts List of the standard drawing template will show the concrete pipe (CP) list branch expanded by default, but this can be collapsed to help in searching for a Corrugated Steel Pipe (CSP), for example.
Name the culvert “pipe network” something that will readily identify the culvert from the others in the drawing. Preface the name of culverts under the mainline highway with “CL” so they can be easily distinguished from entrance culverts and picked out in listings for inclusion in profiles, etc.

Pick the appropriate item from the parts list, leave the “surface name” option as “none” and indicate that the line string represents the outside top of pipe for example, for a CSP, by using Use Vertex Elevations > Outside Top. If an alignment already exists for referencing the pipe, it can be selected from a drop-down list.

Press OK. See sample dialogue box:

![Pipe network creation dialogue](image)

**Figure 56 – Pipe network creation dialogue. Note Alignment pull-down, and the “Vertex Elevation Reference”**

**Concrete Box Culverts**

If a box culvert has been indicated by CVP field point measurements at the crown (inside top of opening), a line should be drawn between these points first. This line should be used as the subject of the Create Pipe Network from Object command. The MTO Surveyed Culvert Parts List contains a number of preset box culverts of various width and height size combinations. The pipe object should be drawn using the crown point (the obvert) option in the “USE VERTEX ELEVATION” panel of the pipe creation dialogue box in this case.

**Caution: Wall Thickness of Box Culverts are approximated**

For simplicity, box culvert wall thicknesses have not been modelled exactly in the MTO standard parts list. Although real box culverts may have wall thicknesses ranging from about 220 mm to 400 mm, the box culvert items in the list have walls of 250mm thickness. The width and height dimensions of the culvert items reflect the opening width and height. Thus,
actual depth of cover over, and distances to nearby items from the outer box surfaces may not be modelled precisely in the CAD representation.

**Skew Ends** – Note that the walls of the object thus created will be simple parallel offsets to the centreline, so box culverts with skewed ends will not be fully represented, as was also the case with Land Desktop. Skew ends may have to be field-detailed using the CO (Concrete Outline) code as indicated in the Field Code Feature Sketches document if, say, designers anticipate having to add extensions to them.

### 18.2 Referencing the Pipe Catalogue to Add or Revise Pipe Dimensions

The MTO Parts List of the drawing template contains a large list of items commonly encountered on MTO highways. This should be used wherever possible, with modifications made to the label text to reflect actual dimensions.

In the event that a part with a very different dimension is required, you will have to add the part item by first editing the parts catalogue, from which items can be added to the drawing part list, but this is a somewhat involved task.

By default, Civil 3D places a Pipes Catalogue in `C:\ProgramData\Autodesk\C3D 2013\enu`. If another pipe catalogue is to be referenced, this can be done by browsing to the appropriate folder from **[Home]** > **[Create Design]** > **Set Pipe Network Catalogue**:

![Figure 57 – Setting Pipe Network Catalogue](image)

Use **[Home]** > **[Create Design]** > **Part Builder** command to provide access to the catalogue. The part builder will allow the creation of new part families, with dimensions as needed. Here, new part “chapters” can be added, or new part sizes added. These must be saved in the part builder before exiting it.

A New Parts List can be added with **{Right Click]**ing the **Parts List** branch of the Pipe Network > **Create Parts List**, and assigning a name.

The newly created part families of the edited catalogue can be added to the parts list.

### 18.3 Label Pipe in Plan View

In the CAD drawing, deselect the culvert string and select only the pipe object. Right Click and > **Add Label** to automatically create a diameter(mm) x length(m) label above the pipe.
19. Add Parcel Fabric

19.1 General

Drawing parcel and highway line work involves assessing the position of found boundary monuments against those shown on plans and other title documentation by reviewing measured distances and angles. Once that is done, parcel fabric from subdivision, reference, or other plans can be added either by XREF or INSERTING from existing CAD drawings, or by creating freshly within Civil 3D by using one of three methods:

(a) using graphical Civil 3D figure creation commands
(b) by entering commands from the Survey Command Window, or by
(c) using the Coordinate Geometry Editor

19.2 Querying Distances

There are several ways to query distances in Civil 3D. Some suggested methods are provided here:

19.2.1 From the [Analyze] tab > [Inquiry] Menu:
- The LIST SLOPE command will provide “Horiz. Dist=
- The CONTINUOUS DISTANCE command will allow multiple distance queries from a single base point, or multiple distances in succession
- The DISTANCE command may be used, but note that the default distance provided by this command is a slope distance, unless all object snapping is forced to Z= 0 with the OSNAPZ variable set to 1 (true) and ELEVATION variable is set to 0. (See * below)

19.2.2 Aligned Dimension

[ANNOTATE] > DIMENSION > ALIGNED command
(This can be used for angles as well.)

19.2.3 Label Between Points

[ANNOTATE] > Labels > Add Label > Add line between two points

19.2.4 Civil 3D Feature Line

Draw a feature line between two points and then label the feature line by right clicking on it.

19.2.5 Label Line

Draw a simple line using the [HOME] > Draw Line > command, and then label it with

[ANNOTATE] > Add Label > Add single line/curve label.

19.3 Querying Distances to 3D Objects: Drafting Object Snap at Zero

Any line work representing township, municipal, lot, highway or other boundaries should be drafted in 2-Dimensions so that distances annotations and queries properly reflect horizontal, rather than slope distances. The template’s description key set drives survey monument points to Z=0, so querying distances between monuments should be straightforward. If que-
trying or annotating dimensions between buildings or other items in 3D space is needed, however, one has to select the features’ (X,Y) positions at a forced elevation of zero.

We can force our object snaps to Z=0, overriding the cogo point object elevations, as follows:

First, \textbf{Right Click} while over the drawing window to call up the Options Dialogue box, and toggle the “Replace Z value with current elevation”:

![Options Dialogue Box](image)

Second, ensure the current drawing elevation = 0:

At the AutoCAD command line, type “elev”, then “0” in response to the prompt:

\textit{Command: ELEV}
\textit{Enter new value for ELEVATION <0.000>: 0}

If you want to revert to 3-D editing, undo the first step; If creating an alignment from the monuments (below), you will want to continue drafting in 2-D.

\section*{19.4 Graphical Line Creation}

This is the easiest method to use, in most cases. Line work may be drawn using a multitude of options under the [Home] menu ribbon > \textbf{Draw} > command panel. Lines may be drawn by point number input, point selection, bearing, turned angle, and so on. Arcs, polylines, and other objects can be created in a variety of ways from the same panel.
19.5 Figures by Survey Command Window

As with *Land Desktop*, Civil 3D 2013 allows working with ASCII text batch files to create points and figures and perform inverses and intersections by means of issuing fieldbook type commands. The advantage of doing so is that you will be able to record all commands issued and results obtained by means of batch and output files, respectively. This could be useful when, say, a traverse of turned angles and distances from old field notes has to be entered.

Alternately, if a very long series of parcels has to be entered, the courses from a survey plan could be copied into a text batch file to be run by the CAD operator when suitable.

Any errors can be corrected by simply editing the input batch file and re-running.

The Survey Command Window is invoked from the Toolspace Survey Tab by {Right Click}ing a named network > [Survey Command Window].

You need not commit all survey commands to memory: they are listed in the Civil 3D Help file under Survey > Survey Command Reference > Survey Command Language Commands.

19.6 Coordinate Geometry Editor

A third option to create parcel fabric is to enter the courses by way of the Coordinate Geometry Editor, which allows courses to be entered using a spreadsheet interface.

Open the Coordinate Geometry Editor from the [Analyze] Tab > Ground Data > Survey item.

The editor allows the entry of a series of courses by bearings or angles, which, where a closure is obtained, may be balanced to distribute small random errors. The courses may be turned into a polyline, with optional cogo point objects inserted at their vertices.
20. Create Existing Alignment

[Optional]

Most MTO regional Terms of Reference (ToR) will expect Civil 3D alignment objects to be created in CAD to represent the existing highway geometry as surveyed, to within a typical tolerance of 0.3 metres from the appropriate crown or driving line. These alignments should **not** be considered design features, and are subject to revision by designers. Rather, they are for the purpose of providing a record and referencing such objects as legal and control survey monuments, culverts, bridges, overhead wires, and the existing grade profile.

A full explanation of the Civil 3D commands used to create an alignment is outside the scope of this manual, and reference should be made to the software Help Manual for details. What is provided here is some general guidance for some different approaches to the task.

20.1 Set Up Alignment Key Points and Draw Alignment Elements

Layer SP-E-ALI is suitable for drawing temporary construction lines for this.

In many cases, legacy H&V sheets will be provided as part of the project reference material, and these will provide an idea of where spirals and curves should be attached to tangents, and what their various parameters (length, radius, A value) should be to obtain the optimum fit to legal monuments and constructed centreline features on the ground.

Create geometric key points in the drawing using legal monuments depicted on legacy drawings and fit curves and tangents to them as required to recreate the alignment.

20.2 Alternate Method 2: Best Fit

Civil 3D can perform a very good best fit to crown surveyed points. **Use Best Fit > Create from entities**, then pick **only** the points along the crown, or pick a point group that has already been created to represent the crown points. Select suitable parameters for the alignment geometry, and then create the alignment.

20.3 Alternate Method 3: Create Alignment From 2D Polyline
Note that the Civil 3D [Modify] tab > Design menu item (expanded) > will allow conversion of 3D polylines to simple (2D) polylines that can be used to help create a Civil 3D alignment object. Use the Create from Objects command from the Alignment pull-down menu.

20.4 Apply MTO Standard Labels to the Alignment

The alignment creation command has been set up to automatically create geometry labels and 100-metre interval stationing labels.

Point of Intersection (PI) and Alignment Intersection labels need to be added to layer SP-E-AL-CL-T.

Prior to doing so, ensure that the alignment properties [Point of Intersection] tab has display options set to “By change in alignment direction”.

Create PI labels using the command sequence,

[Annotate] tab > (Labels and Tables) Add Labels > Alignment > [Point of Intersection] or [Multiple Point of Intersection] {to do all PI’s at once}

A style, “MTO_ALIGN_PI_Label”, has been set up for these standard MTO PI labels.

If the PI stationing label is not on the outside of the highway curve, select the PI label and change its “Flipped” setting to TRUE.

Label Intersection of Alignments

To add a label at the intersection of two alignments, use:

[Annotate] tab > Add Labels > Alignment > Station and offset fixed > {then graphically select the main route alignment} > {then select the exact intersection point} > {then after the prompt, select the second alignment} > [RETURN]

This will create a label next to the intersection, using the style, “MTO ALIGN INTERSECT DUAL”. Then select the label alone, and, using the square grip, move the label to a suitable spot on the plan.
If there are problems with alignment labels overlapping topo details, the styles' offsets can be modified within the style, or alternately, the label can be exploded to text and then manually moved to suit. (Remember though, that any alignment modifications made after exploding will not be dynamically reflected in the label text, of course.)

Add Angular Dimension at Intersection

Label the angle of intersection of the two alignments with a label on layer SP-E-ALI-T

21. Export H & V Information

A listing of points may be written to a .CSV text file with their point number, description, alignment station and offset, and northing easting coordinates. See Appendix E for more information.

Use Courier or a monotype font when printing or exporting if you want to maintain uniform column spacing.

Sample Extract from .CSV text file generated by the Station Offset routine:

```
Hwy 589  (Courier Font)
12+550.00
15+561.78

11682  SIB   12+550.15  5379733.755  352812.048  18.67
326  VCP   12+662.65  5379846.851  352811.511  412.005  23.36
26  HCP   12+669.39  5379852.610  352795.181  413.816   7.50
11769  SIB   12+774.66  5379961.042  352787.647  20.12
327  VCP   12+887.43  5380071.383  352746.487  410.666  25.49
```

Alignment Geometry by itself can be exported using the Civil 3D [Toolbox Tab] > Reports Manager > Alignment > Station_and_Curve

22. Create Profiles of Mainline Highway

(Option --- for assignments requiring existing profiles.)

22.1 Create Surface Profile

From the Home tab Create Design segment, pick [Profile] > [Create Surface Profile]

22.2 Add Components

Select appropriate Alignment and Surfaces from the options provided.
Include any bridge deck surfaces that are required. Press [Add>>] to add the items to the list of profiles in the lower window, then [OK].

![Create Profile from Surface](image)

**Figure 62 - Alignment over surface + Surface = Surface Profile**

The [Draw in profile view] option button will initiate the Create Profile View wizard-type dialogue box.

Answer the prompts of the Profile View wizard in turn:
- Name the Profile View something meaningful, such as “Hwy 37 CL as surveyed”
- add the pipe network objects as needed

After the last dialogue box, you will be prompted to pick a point on the drawing that will represent the lower left corner for the profile view grid drawing, and the profile will be generated.

![Figure 63 – Portion of Profile of Existing Highway with culvert and culvert label](image)

**Labels for Various Features**
Various features may be projected to the profile from the plan view, and labelled. A number of different profile label styles are included with the template and can be selected from pull-down lists when modifying properties. Water levels, overhead wires, intersecting road alignments, catchbasins and manholes should be added to the profile and labelled appropriately.

### 23. Add Drainage Features to Profiles

This is only needed if the pipe objects have not already been selected from the automated command prompts of the Profile View creation task of 22, above.

#### 23.1 Select Pipe Objects to call up the Pipe Networks Menu

#### 23.2 [Network Tools] > [Draw Parts in Profile]

#### 23.3 Select Profile View

- Select the profile on which you want the object drawn by picking it in the drawing.
- The object will be drawn to scale on the profile and can be labeled with default labels.

Note that the label style for circular culverts is different from that for box culverts, as the latter have width and height dimensions.

#### 23.4 Add labels for point drainage features

- Select profile view
- Select cogo point items (e.g., CB, DICB, MH) one at a time
- Ensure label style is selected from dialogue box

#### 23.5 Add labels for other features

Other label styles have been created to label features such as:

- Overhead wire clearances
- Water body elevation
- Intersecting alignments of other highways and roads
24. Summary of Deliverables

The following is a list of the minimum CAD deliverables requirement for MTO survey projects:

1. AutoCAD 2013 drawing (.DWG) file with all Civil 3D drawing objects in model space in the appropriate coordinate system for:
   a. Existing and newly established horizontal control and topographic points
   b. Survey figures (line features), symbols, and labels on their appropriate MTO standard AutoCAD layers
   c. Original Ground (OG) surface as generated from those breaklines and points
   d. Separate surface for bridge decks only
   e. Existing best fit reference alignment if applicable
   f. Profile View if applicable

2. All surveyed existing alignments in the drawing exported to a single LandXML format ver. 1.2 file.

3. Figure prefix database used to create the drawing, if modified from the MTO standard

4. A listing of all horizontal and vertical control points with their grid coordinates, station and offset from reference alignment, and elevations with respect to the vertical datum specified, sufficiently identified by Location, Assignment, Date of Survey, Surveyor, Highway Number, etc.

5. A listing of all legal monuments found with their grid coordinates, station and offset from reference alignment, and elevations with respect to the vertical datum specified, sufficiently identified by Location, Assignment, Date of Survey, Surveyor, Highway Number, etc. (See MTO custom routines package, Appendix E)

6. The Civil 3D Project Survey Database subdirectory and contents used to create the drawing.

7. A plain AutoCAD 2013 drawing equivalent to item 1, with NO Civil 3D objects, created by turning on all layers and using the Export > DWG > 2013 command sequence described later, and named the same as item 1, but with the addition of the prefix “ACAD-“.
25. Creating Survey Data for Designers Using InRoads

Bentley’s Power InRoads v8i version SS2 application will read an AutoCAD 2013 drawing with Civil objects, but note that the objects themselves will not be visible except as rectangular placeholders, unless the .dwg file has been saved with the AutoCAD proxygraphics variable set to 1. The standard MTO drawing template has the proxygraphics variable set to 0.

Opening a drawing that has been saved from Civil 3D allows viewing of Civil 3D 2013 objects, but does not allow the creation of InRoads-styled surface features or TIN’s. Thus the following steps are suggested for producing data that is readily accessible by InRoads and other software.

25.1 Export Alignments and Survey Points

- Export to an XML Schema 1.2 format file using the [Output] > Export to LandXML.
- Select the “All Points” point group, the Existing Centreline Alignments for the main highway and intersecting roads and entrances, and all Surfaces.
- Sites, Pipe Networks, and Corridors may be left unchecked, as these are of little value to non-Civil 3D users.

25.2 ASCII Text Points File

- Exporting a plain ASCII text file of surveyed points is also a good practice as it provides a record that can be used with other software, and this can be done with the [Output] > Export Points using the PNEZD comma-delimited format for consistency.
- Exported points of course should reflect any edits that were required to correct wrong elevations, descriptions, etc.

25.3 Extract the DTM Boundary Component from the Surface Object

This can be used to limit the InRoads surface to the edges of the Civil 3D surface object.

(Note: this step is not needed when exporting the working survey drawing to plain AutoCAD format, since a polyline will be created on SP-E-TIN-BNDY anyway.)

Select the TIN Surface Object to call up the context-sensitive Ribbon menu:

![Surface Object menu, extract objects command]

Figure 65 – Surface Object menu, extract objects command
Answering OK will create a 3-D polyline on the same layer as the TIN boundary component, SP-E-TIN-BNDY.

25.4 EXPORT the Drawing to “Plain” AutoCAD DWG format

This export command converts the Civil 3D survey figures to AutoCAD 2D polylines at Z=0, and converts Civil Cogo Point objects to AutoCAD blocks, so that they are readily useable by AutoCAD or Microstation users. Civil 3D surface object components—triangle faces and contours—will be translated to AutoCAD 3D faces and 3D polylines at their 3D elevations.

Unfortunately, AutoCAD layer filters and layer descriptions are not included in the export.

Assigned Styles Affect Export

Note that only content that is visible in styles assigned to objects at the time of exporting will be exported. For example, surface DTM triangles will only be exported if they are visible in the style assigned to the surface. If a surface style of only contours is assigned to a surface object, the triangles will not be exported.

Export to version 2013 DWG format if the designer is using InRoads SS2 build 0.11.07.615 or later, or version 2010 DWG format if designer requires the older format. For designers using v8i SS1, export to 2007 drawing format.

Note that Point blocks in the exported drawing will consist of the marker component at its surveyed elevation, and a label component at Z=0.

In the layers dialogue, {Right click} on ALL filter and select VISIBILITY> ON and VISIBILITY > THAWED successively

Use the AutoCAD Main Menu pull-down from the uppermost left corner
Then choose the DWG > 2013 option:
A new file, “ACAD-<Current File Name>.dwg”, will be created.

**Note:** The original Civil 3D Drawing should always be retained and provided as a deliverable as well so that any subsequent survey work can be merged or edited using Civil 3D.

**Note:** Testing indicates surfaces should be unlocked first, otherwise an “Erase failed elock violation” error may be encountered.

### 26. Exploded Civ3D objects

An alternative approach is to save the Civil 3D drawing to a new filename, for example `<Current Filename>-EXPLODED.DWG`.

In this new drawing, turn on all needed layers and then select all objects and explode them. This will reduce the Civil 3D objects to AutoCAD objects, but instead of flattening the survey feature strings to $Z=0$, will convert them to 3D line strings **at their surveyed elevations**.

The drawback with this method is that if InRoads surface features are created and written to the same drawing, they will be superimposed on, and duplicating, the existing 3D strings.

### 27. Import to InRoads or Power InRoads v8i

#### 27.1 Create the InRoads Surface

An InRoads surface should be created from the AutoCAD drawings DTM triangles.

(Although InRoads is capable of reading an XML surface that has been exported from Civil 3D, testing shows that not all triangles will be duplicated exactly. (Non-duplicates would have to be corrected in InRoads by manual means, or left as-is where the differences are non-consequential. However, to obtain an exact replica TIN, the method of creating from the CAD triangles described below is strongly recommended.

**27.1.1 Open the AutoCAD drawing in Power InRoads**

Turn on all layers and review the TIN. The TIN can be isolated with [Level Display] > {Right Click} **All Except Element**, then pick a TIN triangle.
27.1.2 File > Power InRoads Import > Surface

27.1.3 Modify the dialogue box fields to bring in the TIN triangle edges as breaklines:

Pressing the [Apply] and [Results] buttons allows a check on the min/max coordinates of the imported triangles elements, and the number of points and lines. Viewing the surface under the Surface Tab should show the elements added as Breakline Features.

27.1.4 Import the AutoCAD Surface Perimeter as an “Exterior Feature” for the InRoads Surface

File > Import > Surface
Modify the settings as follows to import the polyline surrounding the surface. This will limit the extent of the InRoads surface to that created in Civil 3D:
Again, [Apply] followed by [Results] will display the import.

27.1.5 Triangulate the Surface

{Right Click} on the Surface name (eg. Default) then [Triangulate] will create the InRoads TIN. Statistics on the Tin will be provided.

27.1.6 View the TIN in Power InRoads

Power InRoads [Surface] > [View Surface] > [Triangles] will write the InRoads TIN to the layer PD-SF-TRIANGLES

Turn both the orginal and the newly created triangle layers to confirm that they are identical in configuration

27.1.7 Save the surface with a unique name

It is also probably a good practice to lock the triangulation once you are satisfied with the surface.

27.2 Create InRoads Surface Features from the Drawing Strings

Creating InRoads Surface features with their appropriate MTO assigned feature styles allows designers to view the strings in 3D with their appropriate colours and linetypes, and permits annotating breaks in the OG cross sections with standard feature codes.
27.2.1 Using the Power InRoads [Import Surface Advanced] command, Use the Rule Set “MTO_ACAD_to_InRoadsSS2” (from the .XIN file) created to read all the survey features into the surface and assign them their respective MTO InRoads Feature Styles.

27.2.2 [Surface] > [View Surface] > [Features] will write all the strings to Microstation as 3D strings at their surveyed elevations.

27.3 Attach Exported AutoCAD file

Referencing allows the designer to design in a drawing that is separate from the survey drawing and prevents accidental modification of the survey drawing. Entities in the reference drawing can still be selected individually, though.

Tools > Reference > Attach [or Toolbar button]

Specify layer in working design drawing for attaching to, (eg. Layer 0)

The following are the recommended steps that a designer might execute to import the survey data:

Reading 2013 version .DWG Files

Power InRoads SS2 build 08.11.07.615 or later is required to be able to read AutoCAD 2013 DWG format files. Note, too, that some functionality of Power InRoads may require working in DGN (Microstation file) mode.

The use of InRoads and MTO customization for it is described in detail in the InRoads Preference and Standards Manual Power InRoads V8i (SELECTseries 2) of Oct. 2012. It is important that the directory structure set-up process described in that manual be followed to allow what is described here.
Note that there is a .dwg template and XIN file set up for designers available from the MTO Xfer site. These are *MTO_InRoads_Template_SS2.dwg* and *MTO_civil_SS2.xin*.

**Modified XIN file for Advanced Import of Survey Features**

The XIN file to be used for importing features is *MTO_SP_PH_SS2.xin*. This is based on *MTO-civil_SS2.xin* but has had a rule set added to accommodate all standard MTO survey features.
Appendix A. MTO Civil 3D Standards Files

The drawing Template (*MTO_CIV3DSTDS_vX_YYMMDD.dwt*) includes:

a. Layers
   - These follow the *MTO AutoCAD Standards Guide* and include some additional ones to accommodate Civil 3D objects.
   - Descriptions have been added to each layer to describe the content intended for it, and letters denoting whether the feature is a line or point item; designated for PLAN, DTM or BOTH, or INFO; and the required accuracy for measurements.
   - Note that Civil 3D object creation commands reference the appropriate layers of the *MTO AutoCAD Standards Guide*.
   - There are also a number NCS (US National Cad Standard) layers for Civil 3D objects that were packaged with the standard drawing template that was part of Autodesk’s Civil installation that remain. These NCS layers have been left as-is where MTO standard layers did not have to be assigned for surveying purposes.

b. Drawing settings for metric unit dimensions, etc.
   - Note that the drawing annotation scale in the template defaults to 1:1000, but this can be changed to suit the final scale for plotting.
   - When working in a portion of dense detail, the annotation scale can be changed to resize symbols and cogo point text to a smaller size to improve readability.

c. Layer filters
   - These reduce the length of the layer list and can so expedite layer management and the changing of settings and editing of drawings.

d. Layer states (eg, for plotting, Quality Control work, DTM work, etc.)

e. Standard blocks (for feature symbols)
   - Note that the old IESCAD Land Desktop symbols have been redefined in this new template to eliminate block attributes and modify their scaling suitable for Civil 3D.

f. Description Key Set
   - As with Land Desktop, this table allows Civil 3D stylized survey points to be generated automatically on the import of field book (.FBK) files.
   - This table controls the point object layers as one of:
SP-E-PTS-DTM for non-symbol points that belong in the DTM but are NOT
displayed on the Plan

SP-E-PTS-PLAN for non-symbol points that belong on the Plan but are NOT
part of the DTM

SP-E-PTS-BOTH for points that are both part of the DTM and are shown on the
PLAN

SP-E-PTS-INFO for points that are for elevation information purposes only, and
not for inclusion on either the plan or the DTM

SP-E-(<Category:)>BAR/DRN/GND/MISC/RDS/MON/UTL/VEG>-<(MTO standard
Feature Code)> for points with symbols

Point Styles
Style "MTO_PTNUM_ELEV_DESC" is one style created to look like the Land desktop
standard point block, but note that all components reside on a single layer: SP-E-PTS-
TEXT. Several other point styles are based on variations of it with some components
turned off.

Point Symbols
The symbols used as markers in the Cogo points have been re-defined from those used
in Land Desktop to eliminate the block attributes.

Special Point Symbols

Horizontal Control Monument (Primary Horizontal Control)
The full monument COSINE database or CSIS number can be included in the descrip-
tion after the “HCM” code, following a space, and it will show with the symbol.
Eg. A description of “HCM 123456789” will show up in the point label text.

Benchmarks
The full physical description of the monument may be included after the “VCP” code fol-
lowed by a space, and it will appear in the text label below the elevation label as the full
description attribute of the point.

Tree Symbol – Scaling of Crown to Actual size
The tree symbol, SP_TREE, has been altered from the old single-sized version of Land
Desktop in the template so that the crown can be drawn automatically with it’s true di-
ameter.

The required field code sequence is:

TR <trunk diam.> <tree type> <crown diam. (m)>.

The crown diameter is “parameter 3” in the description, and is used for scaling
the 1-metre sized default block marker.
The settings for the “TR” description key are as follows:

![Figure 68 - Tree Point Style](image)

<table>
<thead>
<tr>
<th>Code</th>
<th>Style</th>
<th>PointLabel Style</th>
<th>Format</th>
<th>Layer</th>
<th>Scale Parameter</th>
<th>Font Scale</th>
<th>Use drawing scale</th>
<th>Apply to X</th>
<th>Apply to Y</th>
<th>Apply to Z</th>
<th>Marker No</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>MTO Small</td>
<td>MTO_JM, JMB, JMB, DESC</td>
<td>SP-SM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>MTO Small</td>
<td>MTO_JM, JMB, JMB, DESC</td>
<td>SP-SM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>SP_T8</td>
<td>SP_T8</td>
<td>SP-T8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>SP</td>
<td>SP</td>
<td>SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Figure 69 - Portion of Description Key Set](image)

- Changes to the description keys can be made by Right Clicking the Set name, but it is recommended that you preserve the MTO Standard key set as is, and edit only a copy if special changes are required.

![Figure 70 - Editing the Description Key Set](image)

- Moreover, points that have been generated by manually drafting can be assigned their standard style by selecting the point and (Right Click) > Apply Description Key command.

**g. Point Styles** – Point styles are set up to create MTO standard style civil 3D point objects (not AutoCAD blocks as with Land Desktop). All points except survey monuments are set to be created at their surveyed elevation in the drawing; sur-
vey monument point styles are configured to create points at Z=0 in order to simplify 2D linework.

h. **Point Label Styles** – These are the text labels that display a combination of point attributes such as point number, elevation, and description.

i. **Point Groups defined** – These permit manipulation of groups of points for surface creation, and the assigning of point and label styles

j. **Surface build definition** (should include breaklines and single point features designated for DTM in Point Group)

k. **Alignment Styles, and alignment label styles** – These provide chainage and geometry and PI labels

l. **Pipe Network Parts List** – To provide a “pick list” of culvert types and sizes for creating pipe objects from survey figures to automate drafting

m. **Profile View for existing centreline in MTO style, and Band set for profile elevations at 20 m intervals**

n. **Borders, layouts for multi-sheet production** - [For possible future implementation]

o. **Setting: MSLTSCALE=1**, to allow rescaling of AutoCAD linetypes in conjunction with changes to the the drawing Annotation scale;

p. **Setting: PROXYGRAPHICS=0** reduces the overall size of a drawing file for efficiency but prevents Civil 3D objects from being represented fully in drawings that have had the civil objects exploded. Set proxygraphics =1 and save the drawing if you need to explode Civil 3D objects prior to exporting to other software, so that Civil objects are represented fully, rather than just rectangular placeholders.

**Note:** The March 2015 Drawing version 2 template has this variable set to 0 to reduce file size.

**Survey Related Databases**

- **Survey Database Settings File** – `<filename>.sdb_set`
  (Contains settings for measurement reductions; normally this file is located in `C:\Documents and Settings\All Users\Application Data\Autodesk\C3D 2013\enu\Survey`)

- **Survey Database** (see below for more information)

- **Equipment Database** – various equipment corrections etc. – [user sets up]

- **Figure Prefix Database**
  - Based on modification of the Ontario Kit from Autodesk.

- **Linework Code Sets** – not implemented at this time; these create lines from codes alone, rather than commands on separate lines as within field books, and provide some more control over curved feature creation

Excerpt from the *Civil 3D Help File*:

**Survey Database**
In AutoCAD Civil 3D, survey data is not drawing dependent and is stored in an external database. For display and visualization, survey data can be manually and automatically inserted into a drawing when the survey database is updated or when data is imported into the survey database.

The Survey database consists of two files, the `.sdbx` file is the main survey database and it contains all the data in the survey database collections except for the Extended Properties definitions and values. The Survey `.SDXX` file contains the Extended Properties definitions and values.

**Survey networks and figures persist in AutoCAD Civil 3D drawings as drawing objects.**

**Network object.** Represents a survey network or traverse in the drawing. The network object is a read-only object that cannot be edited in the drawing. If the network is modified in the database, the survey network displayed on the Survey tab in Toolspace indicates that it needs to be updated.

**Figure Object.** Represents a survey feature, or chain of similarly coded points in a drawing.

The figure object can be edited with AutoCAD drawing commands but will display as out-of-sync with the survey database, unless the survey database is updated from the figure drawing object. If other drawings have the same figure in a drawing and the survey database has been updated, their drawing figures are shown as out-of-date and can be updated from the survey database.

**Survey Point.** A special type of COGO Point that is read-only in a drawing session. However, the display properties of a Survey Point can be modified in the points or point groups collection on the Prospector tab in Toolspace. A survey point is read-only in the drawing, because a survey point may have dependent data, such as an Angle, Distance, Vertical Angle, Prism Height, from a specific instrument setup.
Appendix B. Other Standards Consideration

Standardized Directory Organization

Similar to Land Desktop practices, a standard folder structure is recommended for project data so that multiple users in an organization can easily store and find data, and restore from archives at a later date.

One such set up might be <Network Drive>:\Geomatics Civil 3D 2013 Projects\ <Project Name>

Under the <Project Name>, as further example, the following structure and content might reside:

- Correspondence
- Reference
  - Control
  - Legal surveys
  - Eng surveys
    - Legacy LDD Project Subdirectory
  - Civil 3D
    - Figure prefix database <filename>.fdb_xdef used to create production drawings
    - DWG Template
    - Equipment Settings
    - Survey Settings
    - Pipe Catalogue
    - Linetypes
      - “C3D mt- acad.lin” is a linetype file that has been modified slightly from the previously used IESCAD “mt- acad.lin” file to correctly display some linetypes with embedded text
  - Mapping
  - Raster Imagery
- Field Survey
  - Raw files
  - Edited files
- Civil 3D Survey Database*
  - Network 1
  - Network 2…etc
- Production Dwgs
  - Topographic Survey Plans drawing(s) or
  - Topographic Survey Plan and Profile drawing(s)

*Note from the Civil 3D Help files:

In AutoCAD Civil 3D, survey data is not drawing dependent and is stored in an external database. For display and visualization, survey data can be manually and automatically inserted into a drawing when the survey database is updated or when data is imported into the survey database.
The Survey database consists of two files, the `<database name>.sdbx` file is the main survey database and it contains all the data in the survey database collections except for the Extended Properties definitions and values. The Survey `<database name>.SDXX` file contains the Extended Properties definitions and values.

**Survey User Settings**

Survey user settings are set independently for each survey database. Units, unit precision, coordinate zones, paths and filenames for survey object management and many other important settings are controlled with these settings. It will be up to CAD supervisors and operators to ensure all settings are in place as needed.

In many organizations, survey user settings will be similar between projects, however, so some thought should be given to standardizing a single or set of settings files.

Survey User Settings are accessed from the upper left most icon of the survey tab, and can be exported to or imported from a text file (default filename, `MTO Survey User Settings.usr_set`).

By Default, this `.usr_set` file is saved to `C:\ProgramData\Autodesk\C3D 2013\enu\Survey`.

The Survey User Settings control such items as the:

- Default **text editor** for editing fieldbook (.FBK) files
- Path and file name for the **Survey Database Settings** (`*.sdb_set`)
- Path and file name for the **Equipment Database** (for reduction of total station specific measurements)
- Path and file name for the **Figure Prefix Database** (see 1.2 above)
- Path and Linework code set (not used in this guide)
- Settings for interactive graphics (field measurement display)
- Import and export defaults
- Preview and Change reporting settings

**Geospatial Coordinate Systems**

The default location for geographic coordinate systems is `C:\ProgramData\Autodesk\`

A subdirectory will reside there with the name, *Geospatial Coordinate Systems*.

If replacing with the modified MTO version, it may be wise to save and rename the old subdirectory *Geospatial Coordinate Systems OLD*, and copy the new version in its place.
Appendix C. Civil 3D Point Objects

Point Objects in Civil 3D
Whereas Land Desktop defined cogo/survey points as simple AutoCAD blocks, with label attributes assigned to individual drawing layers (Point Number, Elevation, Description) that could be turned on and off as desired for working and plotting a drawing, Civil 3D has made point control considerably more complex. This section describes a review of some key things to consider about points in Civil 3D.

Civil 3D Points are no longer AutoCAD blocks; they are civil objects that have many more attributes which can be viewed and edited with the AutoCAD object properties dialogue box. Note that recipients of a drawing will not be able to edit such points, and will only be able to view them if they have the appropriate Civil 3D object enabler.

Although description key sets can be referenced to control how points will be created and appear, note that there are also “default” point settings that will be used if no key matches a point code.

Point Selection by Node Snap

Selecting Civil points must be done using the NODE object snap setting, rather than the INSERT snap as was the case when selecting Land Desktop point blocks.

Survey points versus Drawing cogo points

Survey points from a fieldbook can be imported into a drawing, but a distinction is made between them and cogo points created in the drawing. Civil 3D provides means of protecting or locking the survey points from being edited so that the original measurements have less chance of being inadvertently altered.

Drawing Settings Tab

Under the <drawingname> Settings tab, point styles and label styles are created and selected. Somewhat confusingly, a point style allows the specification of both a marker layer and a label layer, even though a different label layer can be specified in the label style.

Description Key Sets also reside under the Point branch of the Drawing Settings.

A description key for a survey field code prescribes a point style and a label style for points that are brought in from field book or created by point creation commands in the drawing. The key can also prescribe a layer for the Civil point object, which can be different from the marker and label layers. This point object layer can be toggled on and off within the key set, in which case the layers of the point and label styles go into effect.

Point Groups can be defined by feature code, and these point styles can be assigned point styles by way of editing their properties attribute.

A point style can be set up for the default Civil 3D “All points” point group so that neither labels nor point markers are visible. In the prospector tab, {Right Click} the “All points” point
group and ensure that the point style in the [Overrides] tab is selected accordingly, so that point styles assigned by description keys are overridden.

![Point Group Properties - All Points](image)

**Figure 71 - Overriding Description Key Styles**

<table>
<thead>
<tr>
<th>CAUTION!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevations of drawing points are subject to unwanted modification. Note that Civil Cogo points are 3D objects. If they are scaled for any reason using an AutoCAD command, the <strong>elevations of the points will be erroneously scaled as well.</strong> Do not use the <strong>AutoCAD SCALE or ALIGN commands</strong> on three dimensional Civil 3D point objects.</td>
</tr>
</tbody>
</table>
Appendix D. Layer Control in AutoCAD & Microstation

Layer Filters in AutoCAD 2013

Layer filters are useful for grouping layers in ways that are helpful for allowing you to concentrate on and manipulate only certain layers, and accordingly, for controlling the export of data to other programs.

Below, the screen shot shows logical groupings of layers

Group Filters allow you to simply pick a random or other set of layers and save as a group. (The icon is a funnel with a control panel)

Property Filter lets you select by means of the properties of the layers, e.g. All layers with continuous linetype; all layers with colour red or orange (Icon is a funnel with stacked layers)

In Microstation/Power InRoads V8i ss2, the AutoCAD drawing filters are recognized. Furthermore, the AutoCAD layer descriptions may be added to the Microstation listing by Right Clicking on the column headings and checking on the “Description” field.

Figure 72 - Drawing layers viewed in Microstation/Power InRoads v8i ss2 with layer descriptions
**AutoCAD Layer States Manager** – Takes a snapshot of a selection of layers with their current properties stored (on/off, frozen/thawed etc.)

Layer states are stored in the drawings but can be imported and exported individually as `.las` (ASCII text) files.

![Layer States Manager](image)

**Figure 73 - Layer States Manager**

Access from pull-down menu: you can select a layer state, or pull up the layer state manager.

**Note:** Unfortunately, exporting a Civil 3D drawing to “plain” AutoCAD `.DWG` format removes layer filters, layer descriptions, and layer states from the drawing.

**In Power InRoads**
- ACAD layers come in with the `.dwg` file, but layer states are not recognized
- Microstation does not address ACAD layer states at all; it also does not allow importing of AutoCAD “.las” layer state files.
Appendix E. MTO Custom Routines

The following routines have been provided to assist with survey checks and drafting.

Installation:

Extract the Zipped file and save the folder "IESCAD2013.bundle" to

C:\Users\<Username>AppData\Roaming\Autodesk\ApplicationPlugins\n
You’ll need to restart AutoCAD if it’s already running so that the routines bundle can be loaded by the program.

Once the folder is stored, type the command “mto” at the AutoCAD command line.

This will call up a dialogue box and allow access to a set of commands for help with layer control, plan processing, report production, and other commands. A help file describing the commands can be found under the File > menu item:

Layer Control

The drawing layer filters are presented in a window and can be picked easily to control their on/off/isolate status.

Processing Commands

Rotate Single Points - Rotates selected points and text to match the alignment

Rotate Multiple Points - Rotates all points within specified offset to match the alignment

Extract Text - Inserts a text string only of the description for points with a “TXT” code. This code is no longer needed as any point measured may have a description added after the standard 2 or 3-letter field code, separated by a space, without affecting symbol or survey figure creation when the field book (.FBK) is read into Civil 3D.

Check Alignment Fit - Check the “goodness of fit” of an alignment to the Crown shots. Inserts markers and offset labels at crown points along the alignment on the cur-
rent layer, once the CAD window is selected. Also displays a list of points with station and offset that can be used to zoom to the markers thus produced.

**Draw by Bearing and Distance** - Draws a line by bearing and distance using a simple text entry dialogue box.

**Draw Grid** – Draw 100-metre labelled N/E gridline pattern within a prescribed polygon

![Image](image.png)

**Report Commands**

**STAtion OFFset / HV report for Horizontal and Vertical Control Points**

Produces a station offset report for any point group from a selected alignment. For H&V lists, for example, choose the Legal monuments and Control points point groups.

**Quality Assurance Checks**

This routine includes one tab for checking audit shots against a DTM, and a second tab for checking the distance between points constituting segments of a survey figure. Both routines create a .CSV text file as output, which opens with Excel by Windows default.

For **DTM audits**, you need to populate a points group with the audit (AU coded) points, then select it and the alignment in the dialogue box.

![Image](image.png)

For the **Line Segment Report**, you can isolate the DTM survey figures using the Layer filter included in the drawing template.

<table>
<thead>
<tr>
<th>Layer</th>
<th>Length</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object is not a Survey Figure: SP-E-MON</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object is not a Survey Figure: SP-E-ALI-CL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SP-E-DRN-BD</td>
<td>29.441</td>
<td>5380274.228</td>
<td>352474.6675</td>
</tr>
<tr>
<td>SP-E-VEG-WD</td>
<td>48.222</td>
<td>5380266.915</td>
<td>352480.902</td>
</tr>
<tr>
<td>SP-E-DRN-BD</td>
<td>31.051</td>
<td>5380276.843</td>
<td>352475.5695</td>
</tr>
</tbody>
</table>

**Other Commands** – for importing imagery (MTO Network only), styles or layer filters
Appendix F. Additional Resources

The following lists of links are provided to assist with finding potential sources for technical training, support, or software. This list is not meant to be an endorsement of the organizations or their services or products, and may not be a comprehensive one.

Wisconsin Department of Transportation

This site has extensive syllabi with links to some 80 hours’ worth of video modules in .mp4 format. Plain AutoCAD, Civil 3D for highways, and survey work are covered. It is highly recommended for users starting with Civil 3D.


AutoCAD Value Added Resellers

CANSEL  www.cansel.ca/en/training/
Imaginit  www.imaginit.com/training
SolidCAD  www.solidcad.ca/training/

Software Developers

Eagle Point  http://www.eaglepoint.com
Quuxsoft  http://www.quuxsoft.com/SincpacC3D.aspx
Steltman Software  http://www.steltmansoftware.com